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0.1 Welcome to Photo DVD Maker 

 

Photo DVD Maker allows you to make use of your DVD burner to create entertaining slideshows you can watch on TV. With one click, 

Photo DVD Maker creates an exciting photo slide show complete with music, motion menus and transition effects. With Photo DVD 

Maker you can quickly and easily produce professional-looking photo slideshow DVD disc and share the slide show on home big screen 

TV with standard DVD player in the comfort of your living room. With a few minutes of work, you'll have an eye-catching slide show 

that will run on nearly any DVD player.  

Photo DVD Maker gives photography lovers or photo collectors a new and easy way to view, store and share their pictures from digital 

camera, scanner or Internet. With just a few clicks, you can use Photo DVD Maker to view and edit photo, create and organize your 

photo album, add background music, burn your photo album on blank DVD+R/W or DVD-R/RW disc. After that, you can show your 

creative works on TV through a DVD player. Photo DVD Maker can also archive your original photo files on DVD disc so you can print 

or process them in the future. 
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0.2 Getting Help 

Need help with Photo DVD Maker? There are number of ways to get the help you need.  

• Help and Documentation - This help documentation includes details on every window, feature and function of the software.    

• Email technical Help - The Photo DVD Maker website contains technical support information, ordering information, FAQs and 

more.  Please visit http://www.photo-dvd-maker.com for more information. You may also get our technical support by sending email 

to support@anvsoft.com. 

 

http://www.photo-dvd-maker.com/
mailto:support@anvsoft.com
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1. Getting Started 

What you can do with Photo DVD Maker 

Create a Show with Photo DVD Maker 

Two Important Operations in Photo DVD Maker  

System requirements 

Ordering and registering the program  

Registration 
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1.1 What you can do with Photo DVD Maker 

With this powerful slide show software, you can:  

Create and burn your photo slide show DVD with clicks  

Using the simplified three-step workflow, no experience is necessary to get great-looking slideshows every time. With only a few clicks, 

you can conveniently create your own photo albums. After the preview of your slide show created, you can easily burn them onto a 

blank DVD-R or DVD-R disc that can be enjoyed both on your PC and TV with a DVD player.  

Watch and share your digital photo on TV with DVD player  

With this slideshow software, you can view your DVD slide show on a TV in the comfort of your living room. With its multi-album 

feature, you can just kick back with the remote control and share your albums on the big screen with your family or friends.  

Save and organize your Photo, Picture and Image  

With this photo program, you can easily archive thousands of your favorite high-resolution photos onto a DVD disc that is accessible 

by your PC. You can share your archived DVD+R/DVD-R discs with friends, family, clients or colleagues!  
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1.2 Create a Show with Photo DVD Maker 

Creating a show in Photo DVD Maker can require as little as a few minutes. Photo DVD Maker makes it easy to quickly create a great 

show, but also gives you the power and control you need to create a perfectly timed and composed production. You can spend as little 

or as much time as you'd like creating a show. The time you spend depends on how detailed you want to be in composing your show. 

A basic show with music and motion can be put together in just a few minutes. 

Get to Know about Photo DVD Maker

General Process of Making a Show

Create a Quick Show 

 

1.2.1 Get to Know about Photo DVD Maker 

To get started making a show, there are just a few tips you need to know: 

-- The File Folder List lets you browse for photos and music. Double-click the file and all the pictures in it will be displayed in the slide 

list panel. 

-- Many of the customizations you would like to make can be found in the Photo Configuration widow. Double-click any slide to 

customize its transition effects , Pan& Zoom effect, subtitle, art clips and picture effect. 

-- You can drag and drop slide to your target place. 

-- You can adopt album theme and DVD menu templates to your slideshow. 

-- In most cases, you can operate your slideshow by using drag-and-drop and right-click

 

1.2.2 General Process of Making a Show 

1. Organize & Modify Photos  

After you launch Photo DVD Maker you create a new album and import your photos. Thumbnails will be displayed allowing you to 

drag and drop the order of your photos or fine-tune their appearance further. Add your favorite photos to the newly created albums.  

 

http://www.dvd-photo-slideshow.com/
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2. Add Background Music & Apply Transition Effects 

Next, you select your background music and what kind of transitions you want between photos. These are top notch and there are 

dozens to choose from. 

 

3. Select Album Theme  

Next, you select your graphical theme, many of which use some nice animation. You can add opening and closing credits, too. You can 

click Preview to have a preview of your creative album effect. 

 

4. Choose & Modify DVD Menus 
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After you previewing your creative slideshow in the previous step, you can choose and modify the DVD menu which is applied to the 

slideshow. The DVD menu helps you enjoy your slideshow on TV with the navigation of DVD menu. You can add background image, 

music, descriptive words to the menu. For your ease, you can select menu layout in our built-in DVD menu templates directly. 

 

5. Burn & Enjoy  

Your final step with Photo DVD Maker is to burn your DVD. Here you can choose any technical settings you prefer and burn away. 

To learn more, click here. 

 

Tips:  

You can also make use of default setting to create a show in very quick way. Please refer to Create a Quick Show. 

http://www.dvd-photo-slideshow.com/
http://www.dvd-photo-slideshow.com/
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1.2.3 Create a Quick Show 

Try the following to create a very quick show:  

1. Set Default Setting 

After you run the Photo DVD Maker, please choose the Options in the Menu of View. Then set your default setting in the Options 

Window, including transition effects and background music. You can also set the parameters of your output file, including its DVD 

menu, format, playback order, etc.  

2. Add Photos 

Select your desired file folder in the File Folder List and its content will be displayed in the Slide List. Drag-and drop your selected 

photos to the Slide Panel. You can arrange your slides after they are added by clicking and dragging them in the Slide Panel.  

 
3. Burn Disc  

You can choose the Burn Disc on the main window directly. Click Burn Now and your slideshow will be burned onto a disc with only 

few minutes. 

After these three easy steps, you can enjoy your creative slideshow DVD with DVD player. But if you want make your slideshow more 

animated and personalized, please follow our step-by-step guidance.  

1.3 Two Important Operations in Photo DVD Maker 

In Photo DVD Maker, drag-and-drop and right-click are the two quite useful and important operations. 

1.3.1 Drag and Drop 

You can finish drag-and-drop with the following three steps: 

Step 1: Select the resource object you want to drag. Press the left key of mouse and hold on.  

Step 2: Move the object to the target position. Once you begin to move , you will see a shadow of the selected object move with the 

moving of the mouse. 

Step 3: when you move the selected object to the desired position, please release the left key and it will be moved to your desired 

position. 

For example, if you want to apply a transition effect (Star-5. Point-Rotate) to the selected slide (the first slide in the list), you can do 

that as follows: 

1. Select your desired transition effect in the transition icon list.  

Select the transition effect Star-5. Point -Rotate and then press the left key of the mouse and hold on.  

 
2. Move the selected transition to the transition effect icon of the first slide. 
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3. Release the left key of the mouse and the previous transition, Zigzag Wipe.T to B, will be changed into the Star-5.Point -Rotate. 

 

If you want to drag more than one target at the same time, please press the Ctrl (for inconsecutive targets) or Shift ( for consecutive 

targets) while dragging and dropping.  

In Photo DVD Maker, you can create your slideshow more quickly and conveniently with dragging and dropping. Here, you can see 

where you may use drag-and-drop in Photo DVD Maker. 

1. Add and Rearrange Photos 

--Drag and drop your desired photos from the slide list to the slide panel and add them to your slideshow. (Learn More)  

--Drag and drop the thumbnail of the slide in the slide panel to rearrange the slide order in the album. 

--Drag and drop your desired slide in another album to the target album to move the selected slide to your target album. 

2. Create and Rearrange Album 

--Press Ctrl and then drag the thumbnail of a selected album to your desired target album, then the selected album will be copied to 

the target album.  

--Drag and drop the thumbnail of the album in the slideshow list to rearrange the order of the album.  
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3. Set Album Thumbnail  

--Drag and drop the selected slide to the slideshow thumbnail in the slideshow list, the selected slide will be set as the thumbnail of 

the target album. (Learn More) 

4. Add Background Music  

--Drag and drop your desired music from the file list to the background music list to add the selected music to the album as the 

background music. (Learn More)  

--Drag and drop your selected background music from the added background music list onto the selected slide thumbnail or transition 

icon to make the music start from the slide or the transition effect. 

Step One: Select your desired music in the added background music list and the target slide or transtion effect. (We choose to make 

the first music in the list to start in the third slide)  

 

Step Two: Press the left key of the mouse and hold on, and then begin to move the music onto the target slide thumbnail. 
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Step Three: Release the mouse key and you will see the time line start from the third slide. 

 

5. Configure the Start Point of the Background Music  

--Drag and drop the time line of the selected background music onto certain slide or transition effect icon to make the selected 

background music start from this slide or transition.  

6. Add Art clips  

--Drag and drop your desired art clips from the provided art clips to the slide to add the art clips to the slide. (Learn More) 

7. Place the Onscreen Text of DVD Menu  

--Drag and drop the onscreen texts on the DVD menu to your desired position quickly. 

1.3.2 Right-Click 

Press the right key of the mouse, and generally, there will be a pop-up menu. You can modify your slideshow very conveniently. In 

Photo DVD Maker, you can have right-click in following occasions.  

1. Add and Select Photos  
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--have a click on the selected photo in the slide list to choose add it to the current album or select all the photos in the file folder. 

 

2. Create and Delete Album  

--have a right-click on the slideshow list panel, you can choose to create new album, delete selected album, view the properties of the 

slideshow or have a batch collect. 

 

3. Modify the Slide in the Album  

--have a right-click on the selected slide and you can choose to remove it , remove all the slides in the current album, set the selected 

slide as the thumbnail, add blank image or rearrange the current slide order. 



Photo DVD Maker User Manual 
 

16 

 

4. Apply Transition Effects  

--have a right click on the selected transition effect icon, you can choose to apply it to the selected slide or to all the slides in the 

current album. 

 

--have a right-click on the slide panel to select some of transition effects from the built-in transition effects to apply the album or the 

entire slideshow randomly. 

 

5. Add Art Clips and Onscreen Text  

--have a right-click on the selected added art clips or onscreen texts, you can choose to copy, delete or apply to all the photos in the 

current album. 
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1.4 System requirements 

Intel Pentium III 800M HZ Processor and above  

Microsoft Windows 98, ME, 2000, XP  

256 MB of RAM (above is recommended)  

200 MB of available hard drive space for program installation  

DVD-R/RW or DVD+R/RW drives for burning DVD  

Windows-compatible sound card (recommended)  

TV connected to DVD player (recommended)  
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1.5 Ordering the Full Version of Photo DVD Maker Professional  

There is no time limitation on the free trial version. But it only supports maximum 36 photos on photo album. The registered version 

will remove this limitation. There will be no logos printed on the burned DVD/CD slideshow disc created by the registered version.  

The registration fee of Photo DVD Maker Professional (Personal License ) is USD49.95 . Please visit 

http://www.photo-dvd-maker.com/buynow.html for more information.  

Personal License ( USD49.95) 

--You may install and use one copy of the SOFTWARE on a single computer. You may make a second copy of the SOFTWARE and install 

it on a portable Device for the exclusive use of the person who is the primary user of the first copy of the SOFTWARE Product. At no 

time may the SOFTWARE be used by other individuals than the licensed users.  

--This license does not grant you the right to use the SOFTWARE to create photo slideshow DVD discs for commercial sale and 

distribution. You need to obtain a Site License or World License for that commercial purpose.  

Site License (USD149.95) 

--You may install the SOFTWARE on no more than five (5) computers in your company. The SOFTWARE can be used by no more 

than five (5) users in your company.  

--The DVD discs generated by this SOFTWARE can be used with an unlimited number of users, provided they are developed solely by 

your company. This license grants you the right to use the SOFTWARE to create photo slideshow DVD discs for commercial sale and 

distribution.  

World License (USD449.95) 

--You may install the SOFTWARE on every computer in your company. The SOFTWARE can be used by an unlimited number of 

users in your company.  

--The DVD discs generated by this SOFTWARE can be used with an unlimited number of users, provided they are developed solely by 

your company. This license grants you the right to use the SOFTWARE to create photo slideshow DVD discs for commercial sale and 

distribution.  

 

http://www.photo-dvd-maker.com/buynow.html
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1.6 Registration 

When you are using the trial version of Photo DVD Maker, you can only burn maximum 36 photos into each CD/DVD disc.  

After you purchase our product, you will be provided a registration name and code to unlock the trial version directly.  

Tip for registration:  

Run Photo DVD Maker, click the menu Help->Register.... There will be a registration popup dialog. You can input the Name and Code 

manually. (The registration name is case sensitive. e.g., A is not a. And, please do not add blank at the beginning or the end of the 

registration name and code.). You can also copy and paste the Name and Code into the registration popup dialog.  
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2. Photo DVD Maker at a glance 

Creating projects with Photo DVD Maker involves a three-step process where you can Organize your photos into a slideshow album, 

apply a creative DVD Menu to it, and then Burn it onto a blank DVD+R/RW or DVD-R/RW disc .  

(1) Create and organize Albums: Click the Organize Photos button to create photo albums and select photos from the file folders 

on your hard drive and add them to a particular album. You can also add your favorite background music to the photo slideshow and 

select transition effects for the slideshow.  

(2) Set DVD Menu: Click the Choose Menus button to select a type of disc menu which decides how the photo albums will be stored 

on DVD disc. You easily design your DVD menu by adding your favorite background music, background image and favorite text. With 

the menu navigator, you can even set the playback order of the slideshow. You may also preview all slideshows to be burned to the 

DVD disc. It is also allowable for you not to adopt the DVD menu option. 

(3) Burn photo albums to DVD: Click the Burn Disc button to burn your photo albums onto a blank DVD+R/RW or DVD-R/RW disc.  

Then you can enjoy your creative photo slideshows in the comfort of the living room. 
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2.1 The Organize Photos window  

The Organize Photos window is illustrated as the following: 

 

 File Folder List ①  

 Slideshow Toolbar ②  

 Slideshow List ③  

 These three steps are all you need to produce your creative slideshows ④  

 Slide List ⑤  

 Slideshow Property and Preview ⑥  

 Slide Toolbar ⑦  

 Slide Panel ⑧  

Capacity Bar ⑨  

2.1.1 The File Folder List 

The File Folder List lists all photos in the selected file folder. You may right-click in this area and there will be a popup menu as the 

following: 

 

2.1.2 The Slideshow Toolbar 

The Slideshow Toolbar provides two options: to create a photo album (slideshow) or delete an existing one. There are several ways 

to create a slideshow. You can manually add photos from local drive. You can also add the whole folder and its sub-folders to the photo 

album by “Drag and Drop” the whole folder from the File Folder List area.  
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: Browse for image files in your hard drive, and then add them to create a slideshow.  

: Delete the selected photo album.  

2.1.3 The Slideshow List 

A slideshow is a set of images with its own properties including background music, album theme and transition effects. The 

Slideshow List displays the general information of all photo albums including the thumbnails, total photos and the photo album name 

of all created slideshows. Click a slideshow thumbnail to display included photos in the Slide Panel.  

2.1.4 Slideshow Property and Preview Tabs 

For every photo album, there are four Tabs to easily set up parameters such as photos, transition& music effects, album theme and 

preview the selected photo album. 

 

2.1.4.1 Album Photo tab 

Click this tab to see all the slides in the current album. 

 

2.1.4.2 Transition & Music Tab  

Click the Transition& Music tab on the Organize Photos window and you will see a window as the following. Here, you can edit the 

transition effects and background music of the whole slideshow or the selected slide. It is also allowable to add the track from the CD 

or your recorded audio files. 
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Tool Bar: you can add and modify background music as well as apply transition effects by using these tools.  

 

Added Background Music List 

 

1. All the selected background music will be shown here.  

2. Click the selected background music in the list and you will see the time line will jump to the corresponding position of the selected 

background music.  

3. Double-click the selected music to trim it. 

4. Drag and drop selected music to photo thumbnail or transition icon on the time line control to set starting slide for the music.  

5. The background music which is fit for the slideshow duration will be marked by , while the unfit one will not be marked.  
 

Transition Effects List 

 

1. All the built-in transition effects are listed in their icon form here.  

2. You can apply your desired transition to the selected slide by double-clicking the icon or just dragging and dropping the icon onto 

the slide or its previous transition icon. 

3. If you want apply the selected transition effects to all your selected slides or all the slides in the current album, you can right-click 

the desired transition icon and then choose to Apply to Selected Photo or Apply to All Photos in Current Album. Press Ctrl or 

Shift key while selecting more than one slide. 

 

Slide Panel 

 

1. All the slide and their corresponding random transition effects icons are displayed here.  

2. You can double-click the transition icon or the slide to customize each photo.  

3. Right-click on the slide panel and you can set the subset transition effects for your album.  

 

Transition Preview Window: you can have a preview of your selected transition effect here.  

 

Time Line 

 

1. It displays the audio length. With the time line, you can see where the audio file starts and where it ends.  

2. When you select more than one audio file as the background music, the time line will be divided into several corresponding parts.  

3. You can see whether the duration of your background music is fit for the duration of your slideshow conveniently. The blue part 

shows the duration of the audio files, while the blank part shows there is no audio matched with the slide.  

4. You can make the background music begin with certain slide or transition by dragging and dropping the time line of your desired 

background music onto the selected slide or transition icon.  

 

Album Information Panel 
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1. You can see the slideshow, transition, photo, audio duration and slideshow background color here. 

2. Click  to reset transition and photo duration time. 

3. Click  to match the slideshow duration with the audio duration time. Click  to undo the sync. 

 

4. Set the background color of the slideshow in the color box and the effects will also be shown in the preview window. 

 

Tips: 

 

-- Check the Loop Audio option to playback the added music repeatedly so as to fit the slideshow duration. 

2.1.4.2.1 

2.1.4.2.1 Add and Modify Background Music 

With Photo DVD Maker, You can add your background music from your hard drive, CD or input recorded sources. Moreover, you can 

modify your background music by trimming their duration time or adjusting their playback order. All the added background music is 

shown in the upper panel. The following is the tool bar for modifying background music.  

 

Add: add background music to the current album. 

Remove: delete the selected background music. 

: Move up/down the selected background music in the added background music list so as to change the playback order in the 

album. 

Trim: trim down your selected music to use only part of it as the background music. 

Play: play the background music of the current selected slide. 

Pause: stop to play the background music of the selected slide. 

: move the selected music one second forward or back forward.  

Ripper: import audio files from your inserted CD. 

Record: record your input sources to apply them as the background music. 

2.1.4.2.1.1 Add and Trim Background Music 

1. Click the Transition & Music tab on the Organize Photos window 

2. Click Add button in the tool bar to add audio file from your computer to your slideshow as the background music. These formats, 

including MP3. WAV and WMA are supported. To remove your unsatisfied music, please click Remove button. 

3. If you just want to use a part of the music as the background music, please click Trim button. And then you will see a pop-up 

window as follows: 
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4. Start point: click your desired position on the track indicator bar, then press the Start Point button and the selected music will be 

trimmed from here. 

5. End Point: click your desired ending position on the indicator, and press the End Point button, and the selected music will be 

trimmed down from the start point to here.  

6. Click the Play button to play the selected music. To stop it, please click the Pause button. Click the Return button, you can have 

the music return to the start point you set or the very beginning. 

7. You can change the start point and the end point by clicking your desired poison on the track indicator bar. 

8. The Forward button and the Backward button can help you make the music jump to the End Point or Start Point quickly. 

9. Click OK button to apply your setting. 

Tips: 

--Actually, you can make your background music start from your desired slide or transition by dragging and dropping onto the slide 

or the transition effect icon.  

2.1.4.2.1.2 Add Background Music from the Audio CD 

1. Click Transition& Music tab on the Organize Photos window.  

2. Click the CD Ripper button and a pop-up window will appear as the following: 
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3. All the tracks on your inserted CD will be listed in the left pane. Select your desired one and adjust the volume by clicking Volume 

button as you like. 

4. Click Extract and your selected track will be imported to your slideshow. 

5. Click Close to return to the previous window 

2.1.4.2.1.3 Add Recorded Audio Files to the Slideshow 

1. Click the Record button and a window will pop up like this: 



Photo DVD Maker User Manual 
 

28 

 

2. Select a recording device between Microsoft Sound Mapper-Input and SoundZMax Digital Audio in the drop-down list. 

3. Select your input resource. 

4. Set your recording volume by dragging the indicator. 

5. Select your desired path to save your output WAV file. By default, the file will be saved in the temporary file folder, whose path is 

shown in the below pane. You can change the path by clicking the Browse button the select your desired path. 

6. Click Start Record to begin your recording at once. To stop it, please click Stop Record. 

7. You can see the recording duration time in the pane at the very bottom of the window. 

8. The playback volume of the record input file can also be adjusted by dragging the indicator. 

9. Click Close button to return to the previous window. If you want to apply your recorded file to your slideshow, click Add button to 

select it in the file browse window and add it to the slideshow. You can also trim your recorded file. 

2.1.4.2.2 Configure Transition Effects 

1. All the slides in the selected slideshow as well as their random transition effect icons are displayed in the bottom panel. 

2. Click the selected transition effects demonstration and you can have a preview of the transition in above preview window. Click the 

duration time, which is marked on the transition effects icons in seconds, to see a pop-up Transition Options window as the following. 

You can customize the transition effects here. 
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3. Check the Custom option and adjust transition in terms of effect and duration.. 

4. Select your desired transition effects in the drop-down list and the preview of your selected effect will be shown automatically in the 

right preview window. 

5. Click Preview to preview your selected transition effects repeatedly. 

6. Click OK to apply your customization and return to the previous window. 

2.1.4.2.2.1 Set Subset Transition Effects 

You can apply only several transition effects to your slideshow and let them apply to the show randomly. Click More tab and select 

Randomize transition effects of all photos or right-click on the slide panel, you will see a pop-up window as follows.  
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1. Click Add to add your selected transition in the left Unselected Transition Effect panel effect to the slideshow. Your added effects 

will be shown in the right panel.  

2. Click Remove to delete your unsatisfied one.  

3. You can also click Add All or Remove All to add or remove all the built-in transition effects.  

4. Check the Default setting for next new album option to apply the same transition effects randomly to the next album in the 

slideshow. 

5. Click Randomize to finish setting. 

2.1.4.2.3 Customize Photo Setting 

1. All the slides in the current album and their transition effects are displayed in the Transtion&Music window.  

2. Click the duration time marked on the slide in second to see a pop-up menu as follows:  

 

3. Check the Custom option and adjust transition and photo duration as well as the Pan&Zoom effect.  

4. Select your desired Pan&Zoom effect in the drop-down list. 

5. Here, you can check the Enable Sound Annotation option, which let you add sound resource, such as some descriptive words, 

to make your selected slide more animated. Click Browse to select audio file in WAV, WMA and MP3 format in the file browse pane. 

If you don not have some satisfied audio file, you can click Record to input your sound resource at once.  

6. Click OK to apply your customization and return to the previous window. 

2.1.4.2.4 More Photo Options 

Another Photo Options window will appear if you double-click the selected slide in the slide and its transition icon panel. 
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Here, you can customize your selected slide with more options.  

2.1.4.3 The Album Theme Tab 

You can select a unique album theme, which decides the overall appearance of your album. 

1. Click the Album Theme tab in the Organize Photo window. 

2. Select a album theme from the provided templates in the right panel. 

3. Enter titles and credits in the pane below and set their font, size, color and effect in this pane, too. 

4. You can have a preview of your added titles and credits by clicking Preview button in the pane.  
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2.1.4.4 The Preview Tab 

After you set transition effects, background music and album theme, you can have a preview of your slideshow conveniently by 

clicking Album Preview tab. Then click Play to play your show and click Stop to stop the playback. Click the Pause button to stop 

the album playback at the current point, and click Play to continue the preview. 
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2.1.5 The Slide Toolbar 

 
Add Photo: Add photos to your album from a file folder.  

Add All: Add all the photos in your selected file folder.  

Delete Photo: Removes the selected slide(s) in the Slide Panel.  

Rotate Left: Rotates the selected slide(s) 90 degrees counterclockwise.  

Rotate Right: Rotates the selected slide(s) 90 degrees clockwise.  

Add Text: Opens a dialog box from which you can add text to describe the selected slide(s).  

Auto Adjust: auto adjust exposure  

Background Music: Add background music to the current album  

More: more functions as the following feature  

 

Set as Album Thumbnail: It is used to set any photo in your album as the thumbnail.  

Add Blank Image: It is used to add blank image, which can be edited by you.  

Details: click it, and then you can get the information about the name, size, photo/file date, dimensions and the path of each photo 

selected in the album. Then you can change the order of the album according to any of above information.  

Rearrange to Current Viewing Slide Order: click it, you can change the order of the current show as you like.  

Custom Transition & Pan & Zoom: you can set the transition and Pan & Zoom effects by right-click or double click the selected slide. 

 

Tips: Actually, you can not only customize the transition effects and background music, but add any text, art clip or subtitle to the 

selected slide. Moreover, you may process the selected photo in terms of brightness, contrast and color balance the picture. 
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2.1.6 Disc Size Indicator 

Before you proceed to burn your DVD disc, you should check that the size of your project does not exceed the disc capacity. At the 

bottom of the Photo DVD Maker window is a size indicator. Burning a DVD recordable, the limit is 4.7GB for single layer DVD.  
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2.2 The Choose Menus window 
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2.3 The Burn DVD window 

 



Photo DVD Maker User Manual 
 

37 

 

3. Organize Photos 

3.1 Starting a Project 

 
1. When you run Photo DVD Maker, it automatically opens a new project and lets you start creating a slideshow. A new project always 

uses Photo DVD Maker's default project settings. To see and modify these settings based on your Options, select View: Options.  

2. Always save your project for future editing by selecting File: Save.  

3. To open an existing project, select File: Open.  

4. When you burn your slideshow to the disc, a copy of your show will be saved automatically in the Temporary Folder, which is 

prepared for your future use. If you want to see this folder, just click Explore Temporary Folder or click the Option in the View to get 

more information. 
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3.2 Creating a slideshow 

1. Click  on the Slideshow Toolbar. From the pop-up dialog window, you may input the album name. 

 

2. You can also right-click in the Slideshow List area and choose New Album in the pop-up menu as the following. You can also delete 

a selected album by right-clicking.  

 
3. You can choose Batch Collect, and then a pop-up window will appear as the following. Check the folder containing pictures and all 

photos in the folder will be added to the slideshow with the same name of folders and its subfolders respectively. 
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Tips  

--You can change the order of the slideshow by drag-and-drop the thumbnail in the left-down panel. 

--you can copy the selected album if you press the Ctrl when you click the album. 
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3.3 Deleting a slideshow 

1. Click the thumbnail of the photo album from the Slideshow List area (the left-down panel) to select an album you want to delete.  

2. Click the   button, the selected album will be deleted.  

 

Tips:  

-- When you delete a photo album, all photos inside the album will be removed. But the original photos will not be deleted physically 

from your hard drive.  
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3.4 Customizing Photo Album Contents 

After creating a photo album, you can customize the photo album by adding, deleting photos, arranging the order of photos during 

slideshow playback, adding captions for photos, selecting transition effects.  

3.4.1 Sorting Selected Photos 

The File List can display your photos in Thumbnails or Details view mode.  The Thumbnail mode shows you small previews of each 

photo.  The Details mode provides more information about each photo.  

 

When selecting the Details view, you can arrange your photos in any order by clicking any column such as Size, Type or Modified data. 

 

3.4.2 Selecting Photos from the File List 

1. Click on the thumbnail of the photo you want to operate.  

2. When you click on a thumbnail, its border will turn yellow, indicating it is really selected.  

 

Tips:  

--You can press down the key of Ctrl or Alt when you are clicking thumbnails to select more than one photo at the same time. The 

hotkey of Ctrl+A will let you select all photos.  

3.4.3 Adding Photos to Photo Album 

1. Click the Add button to add the selected photos to the current photo album.  

2. Click the Add All button to add all photos in the current folder to the current photo album.  

 

Tips:  

-- Double-click the photo in the File List, the selected photo will be added to the current photo album.  

-- You can drag any number of photos into your photo album at once. Photos are added to your photo album in the order in which they 

appear in the File List. To select multiple photos, you can click and drag in the empty space in the File List to select an area of files, 

or hold CONTROL or SHIFT while clicking on any slide. To add it to your photo album, click the selected files and with your left mouse 

button still down, drag the selected files into the Slide List. You'll see a highlight bar appear in the Slide List where your slides will be 

inserted.  

-- You can drag-and-drop any photo from one album to another album. Firstly, select your desired photo, and then drag it to the 

thumbnail of the target album in left-down panel. If you press the Ctrl while selecting photos, then you can simply copy the selected 

photos to the target album by drag-and-drop. 

3.4.4 Adding Photos from Folder and File List  

The Folder and File Lists are used to locate content which can be added to your photo album.  These work just like any normal file 

manager and allow you to access any content on your computer.  

 

Folder List  

The Folder List lets you choose which folder's content is displayed in the File List.  The Folder List shows all drives on your computer 

as well as network connections and special folders such as My Documents and My Pictures.  

• Click any folder or drive to view its contents in the File List.  

• Double-click any folder or drive to expand it and show any sub-folders in the Folder List.  
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File List  

The File List shows the contents of the selected folder in the Folder List.   The File List is used to add content to your photo album.  

• Click any photo to select it.  

• Drag any photo into the Slide List to add it to your photo album.  

• Select all photos in the File List by selecting any single photo and right-clicking the Select All from the popup menu as the following.  

 

• Select multiple photos by holding the Ctrl or Shift key while clicking on photos.  

• With multiple files selected, you can drag any number of photos into a photo album at once.  

3.4.5 Removing Photos from an Album 

1. Select photos from a photo album.  

2. Click the   button to remove the selected photos from the current photo album.  

 

Tips:  

-- The original photo will not be deleted.  

-- You can right-click in the photo list area; there will be a popup menu as the following.  

 
-- You may click the Remove in the sub-menu to remove the selected photos from the current album. You may also click the Remove 

All in the sub-menu to remove all photos from the current album.  

3.4.6 Customizing Individual Slide  

Double-click the selected slide, and a window will pop up as the following. You can customize the selected slide in terms of its 

transition effects, Pan& Zoom effect, onscreen text, art clip, and subtitle and image effect.  
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3.4.6.1 Customizing Transition Effects:  

If you are not satisfied with the default transition effect, which can be seen after you choose Options in the View menu, you can set 

it by yourself.  

1. Double click the selected slide and you will see the Photo Configuration window.  

2. Click the Transition tab, and then you can set transition duration and select transition effect from the drop-down list in the marked 

position of the following figure. The duration time is limited between 0 second and 99 second. More than 260 transition effects are 

available. The selected effect will be displayed in the preview window automatically. 

 

3. You may click Preview button to have a preview of your customized transition effect repeatedly.  

3.4.6.2 Customizing Pan& Zoom Effect 

You can not only apply auto Pan&Zoom effect in the Transition&Music window, but also customize it. 

1. Double-click the selected slide and you will see the Photo Configuration window.  

2. Click Pan&Zoom tab and you can check the option “Auto Pan & Zoom for All Photos of the Album” or select a kind of Pan& Zoom 
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effect in the drop-down list. More than 10 effects are provided. 

 

3.4.6.3 Customizing Onscreen Text 

1. Double-click the selected slide. 

2. Click Text and you can add any text to your selected slide. 

3. Double-click the slide or click the Add Text button to enter your desired text. You can change the position of the text by dragging 

it to your satisfied place. 

4. You can also add other macros text to your slide by clicking Add Macros Text button and selecting text in the drop-down list, 

including folder name, current date, etc.  

5. Right-click your unsatisfied text and choose Delete or click the Delete Selected Object button to remove it from the current slide.  

6. Right-click your selected text and choose Apply to All Photos to add it to all the photos in the current album or just select your 

desired text and click the Add Selected to All Photos button. 

7. Click OK button to return to the main window.  
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3.4.6.4 Add Art clips to the Slide 

Adding some art clips to your photos can make your slideshow more animated. Over 30 built-in art clips divided into four categories 

are available.  

1. Double-click the selected slide in the slide panel and a pop-up window will appear as the following. 

2. Click Artclips tab on the window and select a kind of art clips in the drop-down list. Double-click your desired art clips in the below 

panel to add them to the slide or just drag-and-drop them onto the slide. 

3. You can also add any customized art clips from your hard drive by clicking More and then select your favorite ones in the file browse 

pane.  

4. Right-click your unsatisfied art clip and choose Delete to remove it from the current slide.  

5. Right-click your selected art clip and choose Apply to All Photos to add it to all the photos in the current album or just select your 

desired art clip and click the Add Selected to All Photos button. 

6. Click OK button to return to the main window.  
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3.4.6.5 Add Subtitle to the Slide 

Subtitles are the text appeared at the bottom of the screen while playing the DVD and they can be some descriptive words or some 

related information. With Photo DVD Maker, you can add any subtitle to the photo or just select a kind of built-in subtitle, such as file 

name, total number of the photo in the album, etc.  

 
1. Double-click the selected slide and you will the Photo Configuration window. 

2. Click Subtitle to enter your desired subtitle in the text pane. 

3. Click Add Macro Text to select and add other built-in text to your slideshow.  

3.4.6.6 Process the Slide 

You can adjust the brightness, contrast and color balance of the photo here. 

1. Double-click the selected slide and you will see the Photo Configuration window.  

2. Click Process tab and drag the indicator of corresponding parameter to adjust the image effect of your selected slide. 

3. You can apply the Auto Adjust Exposure to the slide here by checking the option.  
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3.4.7 Adding and Editing Background Music 

You can add single or multiple audio files as background music to the selected photo album and customize advanced audio options 

such as timing and duration.  

To add background music:  

1. Select the photo album in the Slideshow List area and click the Transition&Music tab. There will be a window as the following:  

 

2. Click Add button to select your favorite music from your hard drive. 

3. Click Trim to trim your selected background music according to your demand. 

4. Click CD Ripper to import audio files from your CD.  

5. Click Record to record your input resources and then add them as the background music. 

6. The time line will show the duration of your selected audio files. You can check whether your music id fit for the duration of 

slideshow here conveniently.  
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3.4.8 Applying Transition Effects to Photo Album 

Transitions are effects which occur between two slides. Transition effects determine how one slide disappears and the next appears 

within a photo album (slideshow).  

To specify a slideshow transition effect:  

1. Select the photo album in the Photo Album List area and click the Transition&Music tab.  

2. Select transition effects from the transition effects list to apply to the selected photo album.  

3. The selected transition effects will be applied to slides randomly. You may also right-click the transition effects icon list area and to 

Apply to Selected Photo or Apply to All Photos of Current Album. 

 

Tips 

-- Actually, you can simply produce your slideshow with the default transition effects setting. Choose Options in the View menu, you 

will see a pop-up default transition setting window, in which you can also change the setting as you like. After your changes, please 

click OK and all your changes will be applied to your slideshow. 

-- You can apply the transition effects simply by double-clicking it after your select your desired slides. You may also drag and drop 

the transition icon onto the selected slide or its previous transition effect icon. 

3.4.9 Randomizing Transition Effects  

You can select some of transition effects from more than 260 built-in transition effects to apply them to your album or the entire 

slideshow randomly. 

1. right-click the slide panel or select Randomize transition effects to all photos in the drop-down list appeared after you click the 

More tab in the Transtion&Music window. You will see a pop-up window as follows: 
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2. Click Add to add your selected transition in the left Unselected Transition Effect panel effect to the slideshow. Your added effects 

will be shown in the right panel.  

3. Click Remove to delete your unsatisfied one.  

4. You can also click Add All or Remove All to add or remove all the built-in transition effects.  

5. Check the Default setting for next new album option to apply the same transition effects randomly to the next album in the 

slideshow. 

6. Click Randomize to finish setting. 

Tips: 

---You can also set the subset transition effects by choosing Options in the View menu.  

 

3.4.11 Using Pan& Zoom to Your Photo Album 

Pan& Zoom is applied to photo slideshows, and it emulates the pan and zoom effect of a video camera. To apply this effect to a 

slideshow, check the Apply Pan& Zoom Effect option in the Transition& Music window.  

 

Tips 

-- You can also change the background color of your slideshow while it is playing. Check the Background Color option in the 

Transition& Music window and select your desired color in the color box. 

3.4.10 Previewing the Selected Photo Album 

1. Select the photo album in the Photo Album List area and click the Preview tab.  

2. Click the Play button to play the selected photo album or click the Stop button to stop playing the photo album. 

3. Click the Pause button to stop the album playback at the current point, and click Play to continue the preview. 
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4. Choose DVD Menus 

The DVD Menus window lets you configure the menu that appears when your DVD is played. 

    

Menu Thumbnail  

By default, the first picture of every photo album is used as the thumbnail to represent the album on the menu. You can, however, set 

this to any picture. To do so, right-click on the photo you want to select as the photo album thumbnail, and select Set as album 

Thumbnail from the pop-up menu.  
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4.1 Selecting Menu Templates 

Select any of the included templates to automatically set the layout, background and font options. For speed and ease in designing 

your slideshow album, simply select from the list of templates. All the backgrounds, effects, and audio that come with the template 

are automatically applied to your slideshow album. You can double-click the selected template to apply it to your slideshow album. 
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4.2 Modifying Background Music for DVD Menu  

You can modify the background music of the DVD menu with the following steps:  

1. Click Choose Menus tab in the main window. 

2. Click the Background Music tab.  

3. Add or Remove background music as you like.  

 

4.2.1 Adding Background Music to DVD Menu 

Most professionally produced DVDs feature some type of background music during the menu. Photo DVD Maker lets you add music to 

your menus so that you can have this effect on your own output.  For best results, choose a short clip of music that can easily repeat.  

1. Click the Background Music tab.  

2. Click the Add button, there will be a popup window to select a music file from the local drive.  

3. Select an .mp3 or .wav file from the folder tree.  

4. The selected music file with file name and its whole directory path will be displayed on the right of the Add button  

5. It is allowable for you to set the duration of the background music. You can also set the background music as long as the music file, 

but you need more time to encode. Here it is also allowable to extract audio track from your CD. 

4.2.2 Deleting background Music for DVD Menu 

1. Click Choose Menus in the main window 

2. Click the Background Music tab.  

3. Select the background music you want to delete, and click the Delete.  
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4.3 Changing Background Image 

The background appears on all your menu screens and can be any image.  The background you choose has more effect on the 

appearance of your menus than any other option.  

1. Click Choose Menus tab on the main window to enter the Choose Menus window. 

2. Click Background Images tab and you will see a pane as the following.  

 

3. Click Add button to select your desired images from the file browse window. Click Open and the selcted image will be applied to 

the menu. You can see the effect in the above preview window.  

4. Select the image you want to remove and click the Delete button.  
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4.4 Modifying DVD Menu Onscreen Texts 

You can customize the text in your menu in the Edit Tab. You can edit the text or change its font attributes.  

1. Click the Choose Menus Tab in the main window. 

2. Click the Edit tab and then enter your desired text in the text pane or just click the selected text in the menu and make any changes 

in the text pane.  

3. Set the font, size, color and the shadow effect of your entered text as you like. The effect will be shown in above preview window. 

4. You may set the visibility of other texts here. Just check your desired ones. 

5. The position of the onscreen text can be dragged everywhere within the menu as you like.  
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4.5 Setting Playback Order by Menu Navigator 

When you create more than one album in your slideshow project, you can set the playback order of the albums with the help of the 

Menu Navigator.  

1. Click the Choose Menus tab in the main window. 

2. Click the Menu Navigator tab and check the Use DVD Menu option.  

3. Select your desired order in the following drop-down list. 

 
Tips:  

-- You can also set the playback order by choosing the Options in View menu. 
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4.6 Previewing the Selected Slideshow 

1. Select the photo album in the Photo Album List area and click the Preview tab.  

2. Click the Play button to play the selected photo album or click the Stop button to stop playing the photo album. 

3. Click the Pause button to stop the album playback at the current point, and click Play to continue the preview. 
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5. Burn DVD  

Click the button, your creative works with your photo slideshows will be burned to a DVD disc. 

5.1 Setting DVD Burning Parameters 

Record your photo albums to a DVD disc so you can play it on a DVD player. Before burning, some parameters can be set in the 

following window: 

1. Choose your output format: DVD, SVCD or VCD. The following table shows the features of each of these formats: 

Format Video Quality  DVD Player Compatibility  Requires 

VCD Average Good 
CD Writer+ 

CD-R/CD-RW  

SVCD Very Good  Average 
CD Writer+  

CD-R/CD-RW 

DVD Excellent Excellent 
DVD Writer+ 

DVD-R(W)/DVD+R(W)  

Before you proceed to burn your CD or DVD, you should check that the size of your project does not exceed the disc capacity. At the 

bottom of the Photo DVD Maker window is a green color size indicator. If you are burning a CD recordable, the limit is usually 800MB. 

If you are burning a DVD recordable, the limit is 4.8GB for single layer DVD, or 8.5 Gb for double layer DVD. On the left of the size 

indicator is a combo-box for choosing output format. You have the option DVD (default setting), SVCD and VCD. 

2. Select your DVD/CD recorder. 

3. If you don't want to burn the slideshow now, you can check the Create disc image file option, which can save your slideshow in 

MPFG-2 format in the temporary folder. You can burn this image file to the disc next time.  
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5.1.1 DVD File System tab  

 

1. Enter your desired Volume Label, Publisher and Copyright information into the corresponding text pane. 

2. Check the Save original image files on disc option, if you want to save the original files of your slideshow on your burned disc. 

3. Check the Save some additional files on the disc option, if you would like to save other additional files on the burned disc. Click 

Add Extra Files button and you will see a pop-up window as the following: 
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Click Add button to add extra files to the disc. You may delete the selected added file or all the added files by clicking Remove or 

Remove All button. The name of the extra file folder can also be changed by you. After you finish adding, please click OK button to 

return the previous window. 

5.1.2 The TV System tab 

 

1. Select the TV system in your country by checking PAL or NTSC.  

2. Setting TV cropping Proportion by dragging the indicator. (the default value is 10%)  

3. Select your TV Aspect Ratio Correction in the drop-down list. 

4. Check or uncheck Apply anti-flickering filter.  

Tips: 

-- The NTSC and PAL are two different standard protocols for television (TV) broadcast transmission and reception. The NTSC standard 

is used in the United States while PAL is used in other parts of the world. You can select the radio button of PAL or NTSC according to 

the standard selected in your country.  
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5.1.3 The DVD Recorder Options tab 

 
In this tab, you can select the options of the recording speed, simulating and the Burn-proof disc protection.  

• Speed - If your drive supports multiple speeds, this selection allows you to change the speed at which the disk is written.  If you 

encounter problems burning your disc, try lowering this setting.  

• Simulate - When checked, the disc will not actually be burned.  The software will test the burning process to see if it functions 

correctly, but will not actually write the data.  

• Copies - Specifies the number of copies to make of the disc.  If you would like to make more than one copy, enter the number of 

copies to make here.  

• Engine - you can select burning engine between "internal burning engine" and "anvsoft burning engine". if you encounter burning 

problem, you may change the burning engine and/or burning engine driver mode to have a try. You can select the "Using internal 

burning engine" option and change the burning engine from "AnvSoft Burning Engine" to "Integrated Burning Engine" or vice 

versa. Please also select the ASPI Driver as the Driver Mode. 
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5.2 Burning Photo Album to Disc 

Click the  button, your creative works with your photo slideshows will be burned to a DVD disc. 
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6. Appendix  

6.1 List of Countries Using NTSC Video System 

 

Antigua  El Salvador  Philippines  

Bahamas  Ecuador  Puerto Rico  

Barbados  Guam  Saipan  

Barbuda  Guatemala  Samoa  

Belize  Haiti  South Korea  

Bermuda  Honduras  Saint Kitts  

Bolivia  Jamaica  Saint Lucia  

Burma  Japan  Saint Vincent  

Cambodia  Mexico  Surinam  

Canada  Midway Islands  Taiwan  

Cayman Islands  Netherland Antilles  Tobago  

Chile  Nicaragua  Trinidad  

Colombia  North Mariana Island  United States  

Costa Rica  Panama  Venezuela  

Cuba  Peru  Virgin Islands  

6.2 List of Countries Using PAL Video System 

Afghanistan  Guinea  Poland  

Albania  Holland  Portugal  

Algeria  Hong Kong  Qutar  

Angola  Iceland  Romania  

Argentina **  India  Singapore  

Australia  Indonesia  Somalia  

Austria  Ireland  South Africa  

Azores  Israel  S.W. Africa  

Baharain  Italy  Spain  

Bangladesh  Jordan  Sri Lanka  

Belgium  Kenya  Sudan  

Botswana  Kuwait  Swaziland  

Brazil *  Laos  Sweden  

Brunei  Liberia  Switzerland  

Cameroon  Madeire  Tanzania  

Canary Islands  Malaysia  Thailand  

Cyprus  Malta  Turkey  

Denmark  Mozambique  Uganda  

Dubai  Nepal  United Arab Emirates  

England  New Guinea  United Kingdom  

Ethiopia  New Zealand  Uruguay **  

Faeroe Islands  Nigeria  West Germany  

Finland  North Korea  Yemen  

Ghana  Norway  Yugoslavia  

Gibraltar  Oman  Zambia  

Greece  Pakistan  Zimbabwe  

Greenland  Paraguay **  
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7. FAQs 

7.1 Ordering and Registration 

Q: Is the Online Order Secure? 

A: Yes. The online ordering is 100% secure! All data exchanged during the payment process is SSL-secured. Our servers support SSL 

Version 3 and 168-bit Triple DES encryption, and the RSA module and SSL sessions feature 1024-bit encryption. We leave nothing to 

chance when it comes to security. 

Q: What’s the difference between the free trial version and the full version? 

A: The only difference between the trial version and the full version is the limitation that you can only burn maximum 36 photos into 

each CD or DVD disc. After you purchase our product, you will be provided your registration name and code which will unlock the free 

trial version. 

Q: Can I buy your Photo DVD Maker offline? 

A: There are no retail stores selling our products. Please visit http://www.photo-dvd-maker.com/buynow.html for more information 

on how to buy the full version. If you would like to buy our program rather than your credit card, please read the following: 

Please use our alternative payment service provider by clicking the URL: 

https://secure.element5.com/shareit/checkout.html?productid=300031421&language=English

To place an order by mail, fax, wire, and PO (when applicable) please use the online form by clicking the following URL: 

https://secure.element5.com/shareit/checkout.html?productid=300031421&language=English 

Then choose one of these payment options found in the Payment Method section of the form. Once submitted online, you will find the 

appropriate information on how to send your payment to our payment service provider. 

 

http://www.photo-dvd-maker.com/buynow.html
https://secure.element5.com/shareit/checkout.html?productid=300031421&language=English
https://secure.element5.com/shareit/checkout.html?productid=300031421&language=English
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7.2 Installation 

Q: Why I cannot install the update program on my computer? 

A: Please make sure you have exited the program when you are installing the program.  

You may uninstall all previous versions of Photo DVD Maker before you install the latest version. You may uninstall the program by the 

following steps.  

--go to "Control Panel"  

--In the "Control Panel" window, select "Add/Remove Programs"  

--Select the program name you want to remove and click the Remove button.  

Q: Why I cannot run the downloaded setup file? 

A: You probably download a corrupted file due to overloaded network traffic. Please try to download the setup file again for several 

times. Please make sure the downloaded file size is exactly the same as the original file from the download website.  
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7.3 Creating Slideshows 

Q: I need to create more than one album, and how can I do that? 

 

A: you can do that by using the multi-album feature in Photo DVD Maker as follows:  

-- In the "Organize Photos" window, click the "New" button. There will be a pop-up window where you need to input the album 

name. 

-- Select photos and add photos to the selected album. 

-- Repeat above steps to add more slideshows. 

If you need to copy photos from one album to another, please select photos and hold down the "Ctrl-" key and "Drag-and-Drop" 

(left-click then hold down the mouse key and move the mouse to another photo album and then release the mouse key). 

You may also save the project file and continue to edit your photo album next time. You can use the Save As function to save 

multi-copies of the project file when you need to add more photo albums to the existed project file. But every time you need to burn 

to a new DVD-R or DVD-RW (need to be overwritten) after you create the photo album project. 

Q: What is the resolution of my photos shown on TV? 

A: The Photo DVD Maker professional version supports DVD, SVCD, VCD 2.0 still picture as the output format. Please refer to the 

following video file comparison. Normally, the DVD output is the best in terms of the DVD player compatibility.  

Format VCD SVCD DVD 

Resolution(NTSC) 352x240 480x480 720x480 

Resolution(PAL) 352x288 480x576 720x576 

Video Compression  MPEG1  MPEG2 MPEG2 

DVD Player Compatibility Great Good Excellent 

VCD 2.0 still picture format optimizes your digital photos and use the High Resolution Still Picture format which is supported by 

DVD/SVCD. This technique makes photos look great on TV. The resolution of the image shown on TV can be as high as 704x576.  

Q: How many photos can be added to the slideshows? 

A: Photo DVD Maker uses MPEG encoder. Since the output file is MPEG2 format, the capability depends on the number of photos, 

interval time between photos and the background music length. The program can calculate the disc space used when photos or 

background music are added into slideshows. There is no limitation with the photo numbers for each slideshow. The only limitation is 

the disc space of your DVD-R or DVD-RW disc. Normally, One 4.7G DVD-R disc can holds more than 1,000 photos with background 

music. 

Q: I need different Pan& Zoom effect for different slide and how can I do that? 

 

A: You can customize the Pan& Zoom effect with the following steps: 

• Double-click the selected slide and you will see the Photo Configuration window.  

• Click Pan& Zoom tab and you can check the option “Auto Pan & Zoom for All Photos of the Album” or select a kind of Pan & 

Zoom effect in the drop-down list. More than 10 effects are provided.  
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Q: Why I cannot see the added subtitles of my slideshow when I preview it? 

 

A: The subtitle is played on TV and the preview of the program does not show the subtitle. Please play the burned DVD on your DVD 

player connected to TV to show the subtitle. 

Q: why my added background music cannot work? 

 

A: The current version supports mp3 and wav format music. You may add background music for all your photo albums in the Organize 

Photo window. Please do not use any music with license because this program does not support any encrypted music files. Please 

remove the default music before you add your own music. 

Q: How can I apply only a part of the music to my slideshow as the background music? 

A: You can do that with the following steps:  

1. Click the Transition & Music tab on the Organize Photos window  

2. Click the Trim button and you will see a pop-up window like this: 

 

4. click your desired position on the track indicator bar, then press the Start Point button and the selected music will be trimmed from 

here. 

 

5. click your desired ending position on the indicator, and press the End Point button, and the selected music will be trimmed down 

from the start point to here.  
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6. Click the Play button to play the selected music. To stop it, please click the Pause button. Click the Return button, you can have 

the music return to the start point you set or the very beginning. 

7. You can change the start point and the end point by clicking your desired poison on the track indicator bar. 

8. The Forward button and the Backward button can help you make the music jump to the End Point or Start Point quickly. 

9. Click OK button to apply your setting. 

Q: Can I add my recorded audio files to the slideshow as the background music? 

A: Yes, you can. Click the Transition&Music tab on the Organize Photos window. Then click the Record button and a pop-up 

window will appear. You can select your input resource, record volume and save path in this window. After you save your recorded 

WAV format file and return to the previous window, you can click the Add button and select your recorded file in the file browse pane 

and add it to your slideshow.  

Q: Can I add some descriptive words to my slideshow? How can I do that? 

A: Yes, you can. After you click the Transition &Music tab on the Organize Photos window, you can click the blank area of the 

thumbnail of the selected slide, and then you can check the Enable Sound Annotation option in the pop-up window, then you can 

record or add your descriptive words at once. You can make the transition duration as long as the annotation.  
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7.4 DVD Burning and Playing 

Q: How long dose the encoding last? 

A: Photo DVD Maker uses MPEG encoder. Since the output file is MPEG1 or MPEG2 format, the encoding time depends on your 

computer configuration, the number of photos, interval time between photos and the background music length. 

Q: Why there are no transition effects when playing on TV? 

A: Photo DVD Maker professional version supports DVD, SVCD, VCD 2.0 still picture as the output format. Please select SVCD or DVD 

as the output disc format if you need the transition effects. If you select the Still picture as the output format, there will be no 

transition effects available. The High Resolution Still Picture format makes photos look great on TV (resolution is as high as 704x576). 

To support this kind of high quality image format on TV with DVD player, the layout of files on CD is not the same as that of the normal 

video CD which can be played like a movie on TV or computer. This is the reason why this output format does not support transition 

effects.  

Q: Why the program hangs up during the burning procedures? 

A: 1. Please make sure the ASPI driver is correctly setup. You may refer support.html to help you install the ASPI driver.  

2. If your problem persists, please take another brand name of DVD-R or DVD-RW disc to have a try. Please select the output disc 

format as the SVCD or VCD 2.0 Still Picture if you want to burn normal CD-R or CD-RW disc.  

3.You may also try to create an image file with our software and then burn the image file with other DVD burning software such as 

Nero Burning Room to have a try. For example, after you create the image file on the Burn CD window, you may burn this image file 

(.iso) using Nero Burning Rom as the following steps. 

-- In the main window of Nero Burning Rom, click File->Burn Image. There will be a popup window where you can select the .iso image 

file created by Photo DVD Maker. 

-- Select “Burn Now” and follow the steps to burn the DVD disc. 

Q: Where can I find the output MPEG-2 files? 

 

A: After you finish the burning procedure or creating image file, you may find mpeg-2 files in the project subfolder in folder "My 

Documents\Photo DVD Maker\4.0". The file names are "A1_1.mpg" or "A2_1.mpg" etc. You may also click the main menu 

File->Explore Temporary Folder to access all these MPEG files you have created. We will provide more options for the MPEG files 

output in the coming version.  

Q: why my CD/DVD player doesn’t recognize the burned CD/DVD disc? 

A: When you see the main disc menu, please remember to press the digital button (1, 2, 3...) on your DVD player's remote control 

to play the corresponding slide shows. This is the feature of VCD 2.0/DVD standard interactive disc menu. Inside the slideshow, each 

photo will be displayed in the full screen.  

Please try to play your burned CD/DVD disc with this DVD player software on your computer.? You may download the free DVD player 

software from the following links:  

http://www.photo-dvd-burner.com/mpc2kxp6484.zip (for WinXP, Win2K) 

http://www.photo-dvd-burner.com/mpc98me6484.zip (for Win98) 

If the burned CD or DVD disc plays well, there is probably a compatibility problem with your current DVD player. Please play the 

burned CD/DVD disc on another DVD player or burn another brand name DVD-R disc to have a try. You may also try to select another 

DVD menu template. In terms of DVD player compatibility, DVD-R disc is the best. 

If you want to know more about DVD/VCD burning, please visit http://www.photo-dvd-maker.com/support.html 

Q: When I play the burned disc with my DVD player, the Previous and the Next button cannot work, why? 

A: If you select the Still Image format (normal CD-R disc) as the output disc format and do not add any background music, you can 

use the Previous and the Next button of your DVD player to manually access all your photos. But if you select the SVCD (normal CD-R 

disc) or DVD (DVD-R/RW disc) as the output disc format, you could not use the Previous and the Next button to manually play the 

slideshow. The reason is that the SVCD and DVD output is the same format as a movie. What you can do with a movie is to 

fast-forward or fast-backward. 

Q: How can I play the burned disc on my computer? 

 

A: You need to play the burned CD or DVD disc on your DVD player connected to TV. But you can also play the burned DVD disc on 

your laptop computer. What you need is DVD player software to play the burned CD or DVD disc on your computer. Please try to play 

your burned CD or DVD disc with this DVD player software on your computer. You may download the free DVD player software from 

the following links: 

http://www.dvd-photo-slideshow.com/support.html
http://www.photo-dvd-burner.com/mpc2kxp6484.zip
http://www.photo-dvd-burner.com/mpc98me6484.zip
http://www.photo-dvd-maker.com/support.html
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http://www.photo-dvd-burner.com/mpc2kxp6484.zip (for WinXP, Win2K) 

http://www.photo-dvd-burner.com/mpc98me6484.zip (for Win98) 

Q: why my slideshow always stops at the same place? 

A: There are probably some corrupted photos in your slideshow. There are probably very high resolution photos in the photo album. 

You can remove this photo from the photo album and play again to verify this. You may resize all photos to less than 2000x2000 in 

terms of the resolution to have a try.  

http://www.photo-dvd-burner.com/mpc2kxp6484.zip
http://www.photo-dvd-burner.com/mpc98me6484.zip


Photo DVD Maker User Manual 
 

70 

 

7.5 Others 

Q: I need to print the original photos and what can I do?  

A: You need to include the original photo files with the burned CD or DVD disc if you need to use the original photos for printing 

purpose. In the Burn Disc window, there are options to include the Original Photo Files or Background Audio Files. Please check the 

Original Photo Files option to include the original photos on the burned CD. There will be a special folder named "PHOTO FILES" on 

the burned video CD to store all original photos you have added to the photo slide show. You may use these original photo files for 

printing purpose. The program does not support printing photos from the slideshow. 
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